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Overview

Summit software is a Windows® based application that has a series of menus, hot keys, and buttons 
which allow you to acquire, sort, and analyze flow cytometry data then save the data in FCS format. 
With Summit software you can monitor and control the instrument, define protocols, configure 
compensation settings and workspaces, define batch protocol panels, reagents, and tubes, and auto-
compensate data. 

How to Open Summit Software

1 To open Summit software double-click the Shortcut icon on the Windows® desktop. The Select 
database dialog box appears.

Figure 3.1  Select a New Database

2 Select CYAN from the dropdown menu. This will allow you to interact with the instrument in 
real time. It is also possible to work with Summit software offline to analyze previously saved 
FCS data files. 

Now you will either create a new database or open a previously saved database.

Summit Software Overview
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Summit Software Database

A Summit software database is a collection of protocols, samples, and data. After you open a new 
database a workspace appears in which to create histograms and dot plots. It is also possible to open 
existing protocol files that may already contain histogram and dot plot forms.

How to Create a New Database

1 Open Summit Software and click New. 

Figure 3.2  Create a New Database

The Create Database dialog box appears.

2 Specify the folder in which you will save the database. Specify a name for the database and click 
Save. The main Summit software screen will appear.

How to Open an Existing Database

1 Open Summit Software. 

Figure 3.3  Browse to an Existing Database
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2 Browse to the folder that contains the database you would like to open, select the file and click 
Open.

Figure 3.4  Select an Existing Database
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Summit Software Screen Overview

Figure 3.5  Summit Software Screen Overview

Summit Software Control Panel

Most of the operations in Summit software can be accessed through the Summit Software Control 
Panel. The panel is located on the left side of the screen and has a series of buttons across the top. 
You can select each of these buttons to get information related to a particular topic. Each tab 
contains submenus that have options specific to that menu. 

Figure 3.6  Summit Software Control Panel (see number 3. on Figure 3.5)

1. Summit software Main Menu
2. Protocol List
3. Summit Control Panel (to gain access to 

additional screens)
4. Additional Menu

5. Sample List
6. Additional Menu
7. Workspace (with blank histograms)
8. Toolbar Icons
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Acquisition Tab

The Acquisition tab allows you to set the threshold at which an event will be detected by the 
instrument, set the event triggering parameter, designate parameter names, specify the data types 
that will be collected, and set the voltage and gain to be applied to each parameter. From Acquisition 
tab you can also set up specific sample run information and view sample run statistics.

Figure 3.7  Acquisition Tab
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Acquisition Sample Panel

The Acquisition Sample Panel can be customized to display, and later save, information specific to 
a sample run.

Figure 3.8  Acquisition Sample Panel

How to Edit Information Specific to a Sample Run

1 To view editable fields, click the blue additional menu icon and select Edit View. The fields that 
are editable will activate. 

NOTE To return to the previous view click Edit View again.

Figure 3.9  Acquisition Sample - Accessing Edit View Figure 3.10  Acquisition Sample - Editing Example 
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2 Change the information in the Value fields as desired. 

NOTE To individually change a field, double-click in that field, enter the change, and click away 
from the field.

3 To add a new Name and Value to the panel select Add Keyword. The Edit Keyword dialog box 
appears. For more information on keywords see page 3-19.

4 Enter the new information, and click OK.

How to Change Acquisition Settings

IMPORTANT Before data can be acquired, data type parameters must be enabled. See Figure 3.10

How to Change Acquisition Settings 

1 To set the Threshold percentage at which an event will be detected by the instrument, click the 
up or down arrows in the Threshold % field Figure 3.11. To change the event Trigger parameter, 
choose an item from the Trigger dropdown list Figure 3.12.

2 To change the name of a parameter, double-click the name of the parameter in the Name 
column, type a new name Figure 3.13, and then press ENTER.

Figure 3.11  Set Event Threshold Percentage Figure 3.12  Set Event Trigger Parameter 
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Figure 3.13  Change Parameter Name

How to Enable Data Type Parameters 

1 Click the Acquisition tab and locate the Acquisition Parameters panel. Double click in the Peak/

Area/Log field. Select the check box that pertains to the data type you want to acquire. See 
Figure 3.10

NOTE This can also be done by entering edit mode. To enter edit mode, click on the menu icon in the 
acquisition parameters tab and select edit mode.



0000050G 3-9

Summit Software Overview
Overview 3

How to Change Voltage and Gain for a Parameter 

1 Click the Acquisition screen tab and locate the Acquisition Parameters panel. Double click in the 
Voltage field. Type a new value or click and drag the slider until the desired value is reached.

Loading an Existing Protocol

How to Load an Existing Protocol

1 To load a previously saved protocol select File > Protocol > Load.

2 A list of previously saved protocol (.plo) files appears. Select the desired file and click Open.

Creating Protocols

When you open a new database there is a workspace in which to create histograms and dot plots. 
The histograms and dot plots that you create become Protocol 1. It is possible to create additional 
new protocols for this database, or load additional pre-existing protocols. 

How to Create a New Protocol

1 To create a new protocol, go to the main menu and select File > Protocol > New. A new 
workspace appears in which to create dot plots and histograms for the new protocol.

2 Ensure that you have enabled the desired parameters. See figure Figure 3.10.

Figure 3.14  Set Voltage for a Parameter Figure 3.15  Set Gain for the Voltage 
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3 Create dot plots and histograms. See page 3-21.

Switching Protocols

To change protocols in Summit software, go to the Protocols toolbar and select a new protocol from 
the drop down menu.

NOTE Only the protocols that you have loaded into the current database or that you have recently created 
will appear in this list.

Acquiring Data in Summit Software

When you have enabled parameters and created or loaded a protocol you may acquire data.

How to Start or Stop Data Acquisition

1 Click the Acquisition pull-down menu and select Start (or press (F2) ). 

Figure 3.16  Start Acquiring Data

2 To stop data acquisition, click Stop (or press (F2) ). 

Saving Acquired Data

After you acquire data in Summit software you can save the information in FCS format.

How to Save Acquired Data

1 Click the Acquisition pull-down menu and select Save (or press F3).
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2 Select a folder in which to save the data. Enter a file name and select an FCS file type.

3 Click Save.

Cycle Mode

The Cycle Mode cycles events through a buffer to display only the most recent data. This is useful 
during alignment activities. The number of data events displayed at any one time is adjustable. 

How to Display the Most Recent Data During Alignment Activities

1 Click on the Acquisition pull-down menu. 

2 Select Cycle Amount. Set the number of events that should be reached before the data cycles.

Figure 3.17  Setting the Cycle Amount for Cycle Mode

3 Click OK.

4 From the Acquisition pull-down menu, select Cycle or click the Cycle Mode icon on the right 
side of the screen.
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Figure 3.18  Enabling Cycle Mode

5 After you set the Cycle Mode, restart data acquisition for the Cycle Mode to become effective.
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Sample Tab

The Sample tab displays the parameters of the selected sample file, and allows you to change the list 
of parameters visible on screen. From this tab you can also compensate data. 

Figure 3.19  Sample Tab

Auto Load from Sample

When you compensate data, the Compensation Matrix is established and can be saved with the FCS 
file. Selecting the Auto Load from Sample option located on the Sample tab, causes the 
Compensation Matrix to automatically display when you load a data file for analysis.

Figure 3.20  Auto Load Compensation Matrix from FCS File
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Auto Compensation Wizard for Single Positive Controls

Summit software provides an automatic method to obtain a full compensation matrix for multi 
color analysis. The compensation matrix is calculated from single stained controls by the auto-
compensate function.

The following procedure describes how to use the Summit software Auto Compensation feature 
within single stained controls. Although this feature provides an automatic method to compensate 
data, compensation can still be adjusted, fine-tuned, or performed manually or via the 
compensation matrix.

NOTE Additional information regarding compensation can be found in APPENDIX C, Compensation 
Background Information.

How to use the Auto Compensation Wizard for a Single Stained Control

1 Acquire the first single-control sample required for your experiment. The first control sample 
should include an unstained or isotype control for which you will set PMT voltages. From the 
resulting dot plot, you can determine gating if required. Any gates that you want to use must be 
set before you apply Auto Compensation. 

NOTE During the Auto Compensation operation, adjustments to only the size and placement of regions 
are allowed.

2 Run the remaining single control samples and save the data files.

3 Load all control sample files into an experiment folder.

4 Click the Sample tab.

5 Identify or create a dot plot that will be used to adjust compensation. Ensure that the parameter 
for which you are compensating is on the x-axis.

6 In the Sample Compensation panel, click the small, blue icon in the upper-left corner and select 
Auto Compensate from the list.
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Figure 3.21  Select Auto Compensate

7 The Auto Comp Sample dialog box appears.

Figure 3.22  Auto Comp Sample Dialog

8 Select a gate from the Gate list, if applicable.

9 From the Experiment list, select the experiment folder that contains your control samples

10 Select all of the single control samples included in the experiment.

11 Click OK.
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IMPORTANT If you click Cancel at any point in the auto compensation process, you will clear the 
compensation matrix and the AutoComp Workspace.

12 A new Workspace labeled AutoComp is created and the first set of dot plots is displayed. Each 
dot plot places the control parameter on the x-axis and a parameter to compensate against on 
the y-axis. Default auto compensation Dim and Bright regions are displayed and, if a gate was 
selected, it is applied to each dot plot. The Auto Compensate wizard appears.

Figure 3.23  Auto Compensate Wizard

Figure 3.24  Single Control Sample Dot Plots
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13 Examine the % Hist statistics for each histogram. If either the Dim or Bright region contains less 
than 5% of the data for the dot plot, click-and-drag the region until greater than 5% of the data 
appears in both the Dim and Bright regions.

14 When all regions on all plots contain greater than 5% of the data, Click Next on the Auto 
Compensate dialog box. The next set of dot plots will appear.

15 Repeat step 13 until all single-control samples have been compensated. When auto 
compensation is complete, the compensation matrix contains the appropriate values and the 
AutoComp workspace is removed.

Applying VisiComp

To help you better visualize the results of compensation, Summit software includes a scaling 
algorithm called VisiComp that displays 0 and negative values. VisiComp provides a good way to 
verify the results of the Summit software Auto Compensation feature, and allows you to fine tune 
and make adjustments to compensation. 

How to Use VisiComp to Visualize Compensation Results

1 Pre-load all necessary samples (Listmode.fcs files) that are required to perform compensation.

2 Create all plots, regions, and gates.

3 On the Sample tab, click the Compensation panel icon and select VisiComp.

Figure 3.25  Apply VisiComp

4 Use either the auto compensation wizard to set up plots, or manually set up all of the plots that 
you want to use for compensation analysis.
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Figure 3.26  VisiComp Example

5 To adjust the width of the VisiComp linear region click the Sample icon in the upper left portion 
of the window and select Adjust VisiComp. Use the slider tool, or enter a specific value to 
complete the adjustment.

Figure 3.27  Adjust VisiComp

NOTE The adjusted width of the VisiComp linear region applies to all plots and histograms that display 
compensated parameters in any one sample template. Because of this, it is important to display all 
data before you adjust the width. What is ideal for one parameter pair may not be perfect for another. 
Therefore, adjust the width to display the best compromise across all plots.
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IMPORTANT If you turn off VisiComp, any regions that extend into the negative area of the VisiComp scale 
will be moved where they can be displayed on the log scale. Any regions that were entirely in the negative 
area will have a 0 width and 0 height.

6 Create regions and gates to complete your analysis. 

NOTE If you created regions and gates before you applied VisiComp, you will need to verify the location 
of the regions.

FCS Keywords

To customize your view of sample data you can add and remove Keywords.

How to Add or Remove Keywords

1 Click the blue menu icon and select Add/Remove Keywords.

Figure 3.28  Add/Remove Keywords 1

2 Select the check boxes next to the Keywords you would like to display, and click OK.
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Figure 3.29  Add/Remove Keywords 2



0000050G 3-21

Summit Software Overview
Overview 3

Histogram Tab

Histograms and dot plots (bivariate histograms) are created in the Histogram tab. The Create 
Histograms panel displays all of the parameters that are enabled in the Acquisition tab.

Figure 3.30  Histogram Tab

Creating Histograms and Dot Plots

You must create histograms and dot plots in order to display the data you acquire. Prior to creating 
dot plots and histograms you must enable the parameters you would like to collect. See page 3-7. 

How to Create a Histogram or Dot Plot

1 Create dot plots and histograms by selecting the Histogram tab in the Summit Software Control 
panel (see #1. in Figure 3.31). The histograms and dot plots that you create will build a Protocol 
that you can elect to save. 
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Figure 3.31  Creating Histograms and Dot Plots

2 Select one of the following:

 • To create a single parameter histogram, double-click on the X-axis parameter for the 
histogram you would like to create. The frame for the histogram will appear in the 
Workspace on the right of the screen.

 • To create a dual parameter dot plot, click once on the X parameter and twice on the Y 
parameter. The newly created frame for the dot plot will appear in the Workspace.

Maximize Dot Plots and Histograms

To maximize dot plots and histograms double-click on the title bar. This option is useful to better 
see the data, create regions, or set gates. Double-click the title bar again to restore the image.

Change Axis Parameters

To change the displayed parameter in a dot plot or histogram, right-click on the axis you want to 
change and select a new parameter from the menu. The options in the list include the parameters 
that were collected with the current data file.

1. Histogram Tab
2. X-axis Parameters

3. Y-axis Parameters
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Figure 3.32  Change Axis Parameters

Change Axis Labels

To change the label that is displayed on the X or Y axis of a histogram or dot plot, right-click on the 
axis you want to change and select Parameter Properties from the menu. You can enter additional 
fluorochrome, marker, or antibody information in the field labeled Long Name. The information 
entered in this field will be the label displayed along the axis.

View Statistics in Histograms

To view statistics in histograms, click the additional menu icon within the histogram and select 
Show.

Figure 3.33  Show Statistics in Histograms
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Edit Statistics Displayed in Histograms

To select the statistics that will be displayed in histograms, click the additional menu icon within 
the histogram and select Edit Display.

The check boxes that are selected will appear in the statistics window below the histogram or dot 
plot. You can also drag and drop to change the order of statistics. Click OK to apply these settings to 
all histograms by selecting the check box at the bottom of the dialog.

Figure 3.34  Edit Statistics Displayed in Histograms

Figure 3.35  Edit Statistics Displayed in Histograms
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Create Regions in Histograms

To create bar regions in single parameter histograms right-click in the histogram and select Bar 
from the menu. In a dual parameter histogram, right click to create a rectangle, ellipse, polygon, or 
quadrants. Once created, you can click and drag to resize and reposition the region. Once you have 
created regions, the statistics for those regions will appear in the status window below the 
histogram. As you move regions the statistics will update in real time. To delete a region right-click 
and select Delete.

Figure 3.36  Create a Region in a Bivariate Histogram

Renaming Regions

Regions can be renamed to reflect the population inside the region. To rename a region right-click 
in the region you want to rename and select Properties. A dialog box appears. Enter a new name for 
the region in the upper-left text field and click OK. 

Copy and Paste Regions

You can copy all regions from histograms and dot plots and paste into another histogram or dot 
plot. Right-click inside the region and select Copy, go to the next histogram or dot plot, right-click 
and select Paste.
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Manually Scaling Data

To manually rescale data within a dot plot or histogram, click the scale up or down buttons on the 
right side of the screen.

Figure 3.37  Manually Scaling Data

Contouring Data

To Enable Contouring, go to the main dot plot menu and select Display > Contour. Select the Enable 
contours check box. The dropdown menu directly below the check box lists the available contouring 
algorithms. The dialog box contains additional options for maximizing data and smoothing the 
contouring. 

Exporting Histograms to Word

To export a dot plot or histogram to Word, go to the main histogram menu and select Copy > Window 
as Bitmap. Open Word and paste the histogram image into the document. The Copy as Graphic 
option does not include the histogram frame or statistics.

Multi File Display

 • It is possible to display more than one data file or sample. Select the Sample tab in the Summit 
Software Control panel. Click the menu icon and select Duplicate. This will copy the existing dot 
plots and histograms in the protocol.

NOTE All copied versions will be indicated with a different color.

 • You can manually arrange the dot plots and histograms, or you can right-click on the white 
sheet, select Arrange Windows and select the desired option. 

 • To load additional samples, go to the Summit Software Main Menu and select New > Samples. 
Click on a sample name and drag and drop to load additional samples into the templates.
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Create Overlays

Overlays are special histograms where you can display data from more than one sample within a 
single parameter or within a single histogram for one parameter.

How to Overlay Multiple Histograms

1 To create an overlay, select the Histogram tab from the Summit Software Control panel. 

2 Click the drop down menu on left side and select Overlay. Double-click on the parameter you 
would like to use on the overlay.

3 To add data, go to the Main Overlay Menu and select Add Data. The curser will change. 

4 Click on the histogram that contains the data you would like to add to the overlay. 

5 To include additional sample data, go to the Summit Software Main Menu and select New > 

Samples. 

6 Click on the sample of interest and drag and drop it on the overlay.
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Gate Logic Tab

The Gate Logic tab allows you to view and adjust gate logic as well as apply color gating to 
histograms.

Figure 3.38  Gate Logic Tab Displaying an Alignment Protocol and Gating Scheme

Setting a Gate from a Single Region

Gating on the main population in the FSC vs. SSC histogram will clean up the data and %CV values 
in other histograms. This eliminates bead or cell fragments and doublets from being considered in 
the alignment of fluorescent parameters. Gating can be done directly in dot plots and histograms in 
which regions have been created. 

How to Gate One or More Histograms or Dot Plots

1 To gate one histogram or dot plot, right-click in the region from which you would like to gate, 
and select Set Gates from the menu. The appearance of the curser will change. 
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Figure 3.39  Set Gate 1

2 Use the newly changed curser to double-click in a histogram or dot plot in your protocol. Once 
the gate is applied there will be an annotation in the title bar to indicate a gate is applied.

Figure 3.40  Set Gate 2

3 To gate more than one histogram or dot plot, right-click in the region from which you would 
like to gate, and select Set Gates from the menu. The appearance of the curser will change. 

4 Use the newly changed curser to single-click in all of the histograms or dot plots in your 
protocol that you would like gated. When you come to the last histogram or dot plot, double-
click to apply the gate.



0000050G3-30

Summit Software Overview
Overview 

5 To remove a gate, click the main histogram or dot plot menu icon and select Ungate.

Setting a Serial Gate

When a region in a dot plot or histogram is used for gating, the serial gate option works by 
automatically appending any gate regions applied to that plot to the new gate. For example, a dot 
plot is gated based on two regions (R1 & R2). If an R4 region is created in that plot and is used as a 
gate on another histogram or dot plot, the serial gate option defines the newly applied gate as (R1 
& R2 & R4). Electing not to serial gate would apply a gate involving region (R4) only to the target 
histogram or dot plot.

How to Serial Gate Histograms or Dot Plots

1 Open a dot plot gated on region (R1).

Figure 3.41  Set Serial Gate 1

2 Create a region (R2) in the dot plot.

3 Right-click in region (R2) and then click Set Gates.
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Figure 3.42  Set Serial Gate 2

The Combine region and gate? Dialog box appears.

4 Click Yes to activate serial gating. Click No to gate using only the specified region.

Figure 3.43  Set Serial Gate 3

5 Check the Make my choice the default and don't ask me again check box to disable this dialog box 
in the future. If checked, this option is set as the default in Summit software. The default can be 
changed in the Preferences dialog box.

6 Single or double click in a histogram(s) to apply the gate.
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Figure 3.44  Set Serial Gate 4

7 If you selected Yes in step 4, the serial (or sequential) gate logic is applied to the histogram or 
dot plot. The graphic below shows a gated histogram involving regions 1 and 2.

Figure 3.45  Set Serial Gate 5

Gate Logic Builder

The Gate Logic Builder, located on the upper-left portion of the Gating tab, allows you to define gate 
logic and view it graphically.

How to Define (Edit) Gate Logic

1 Select the Gating tab in the Summit Software Control Panel.
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2 Click the upper-left icon in the Gate Logic Builder panel and then click New to create a new gate.

Figure 3.46  Gate Logic Builder

3 Double-click a text field in the Expression column. The Edit gate expression dialog box appears.

Figure 3.47  Edit Gate Expression 1

4 Select one or more regions to be included in the gate, and click OK. Gates can be defined to 
include those events that fall inside or outside specific regions. To clear all selected regions, 
click Clear.
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Figure 3.48  Edit Gate Expression 2

NOTE The number of regions available correlates to the number of regions created in the current 
workspace.

The newly defined gate expression is displayed in the Expression column of the Gate Logic 
Builder column and the current gate scheme is displayed in the Gate Scheme panel.

Figure 3.49  Gate Logic Builder and Gate Scheme Panels

Color Gating

You can apply colors to gates to more easily distinguish gated populations. Double-click in the Color 
column for a particular gate and select a color.

NOTE The order of the color dot plots and histograms correlates to the order of the gates listed in the Gate 
Logic Builder. As an example, if you have a color gate applied to a rare population that is being hidden 
in the background, you can reorder color to bring it to the front and more easily identify those rare events.
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Layout Tab

The Layout tab assists you in manipulating the appearance of your Workspace as well as duplicate 
and share histograms, and print some or all of your Workspace.

Figure 3.50  Layout Tab Displaying an Alignment Protocol

Workspace Page Setup

The Workspace Page Setup panel allows you to add and subtract pages from your Workspace, reduce 
or enlarge the layout, and print the layout.

Figure 3.51  Workspace Setup Panel
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Workspace Page Navigator

The Workspace Page Navigator allows you to click and drag thumbnails of your histograms to 
reposition them on your layout. From Workspace Page Navigator you can also Share, Move, and 
Duplicate histograms between Workspaces.

Figure 3.52  Workspace Page Navigator

Go To
The Go To option activates the selected histogram.

Share
The Share option duplicates the histogram allows you to specify the Workspace where it will appear, 
and keeps the data in both histograms the same if changes are made.

Move
The Move option allows you to move a histogram from one Workspace to another.

Duplicate
The Duplicate option copies the histogram but does not link the data between the old and the new 
copy.

Shortcut Keys

The following list describes the keyboard shortcuts in Summit software.

Table 3.1  Shortcut Keys and Functions

Shortcut Key Function

F1 Opens the Summit software online Help system.

F2 Starts/Stops acquiring events.

F3 Saves acquisition data to a drive (C:, D:, etc.), the network, disk, or CD.

F6 Opens the CyCLONE menu.

F7 Opens the Create New Histograms dialog box for the current workspace.

F8 Opens a window that displays all loaded sample files in the current database.

F9 Opens the Drop Delay Wizard.

Left arrow key Sets the displayed sample in the current workspace or protocol as the first file in the 
Database samples window. If more than one file group is present in the sample 
window (that is, organized in multiple folders), the last sample in the currently 
selected group is displayed. Also repositions a region to the left when selected.
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Right arrow key Sets the displayed sample in the current workspace or protocol as the last file in the 
Database samples window. If more than one file group is present in the sample 
window (that is, organized in multiple folders), the last sample in the currently 
selected group is displayed. Also repositions a region to the right when selected.

Down arrow key Sets the displayed sample in the current workspace or protocol as the next file in 
the Database samples window. If more than one file group is present in the sample 
window (that is, organized in multiple folders), the last sample in the currently 
selected group is displayed. Also repositions a region downward when selected.

Up arrow key Sets the displayed sample in the current workspace or protocol as the previous file 
in the Database samples window. If more than one file group is present in the 
sample window (that is, organized in multiple folders), the last sample in the 
currently selected group is displayed. Also repositions a region upward when 
selected.

SHIFT + ARROW Expands a region in the arrow direction (left, right, up, down) when selected.

CTRL + ARROW Contracts a region in the arrow direction (left, right, up, down) when selected.

CTRL + O Opens a dialog box to open one or more FCS Listmode files.

CTRL + S Saves modified items on the Summit software desktop that have changed (or auto-
save is invoked at periodic intervals and when Summit software is closed).

CTRL + P Prints the current view of the Summit software desktop.

CTRL + C Copies the selected region, which can be pasted into a histogram.

CTRL + V Pastes the copied region into a histogram.

CTRL + D Opens the Sort Logic and Statistics menu.

CTRL + G Opens the Gate Logic menu.

CTRL + Z Clears the event buffer of all acquired events.

CTRL + W Opens the Worklist Panel.

SHIFT + F4 Starts a Hardware Sort.

ALT + F4 Exits Summit software.

+ Expands one node when viewing a folder list in a window (use + on the numeric 
keypad).

- Collapses one node when viewing a folder list in a window (use - on the numeric 
keypad).

* Expands an entire folder tree contained in a window (use * on the numeric keypad).

Table 3.1  Shortcut Keys and Functions (Continued)

Shortcut Key Function
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